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Kapitel 1. Indledning
VANSEnvelope er en XML kuvert til anvendelse på VANS netværket. Den kan anvendes til at trans-
portere vilkårlige data mellem to lokationsnumre og samtidigt give vished for modtagelse.

I den efterfølgende tekst nævnes VANSEnvelope som kuverten. Kuverten definerer en række elemen-
ter, disse anvendes som metadata for den medsendte meddelelse. Der kan føres statistik over afsendte
meddelelser og modtagersystemet kan let vurdere meddelelsens relevans.

Baggrund
Den seneste udvikling indenfor meddelelsesbaseret kommunikation har vist et behov for at afkoble
den enkelte meddelelse fra transportlaget. På baggrund af dette og i samarbejde med VANS leveran-
dørerne implementeres nu en ny kuverttype, hvor alle typer meddelelser kan transporteres uden at
transportlaget nødvendigvis kender meddelelsen.

Struktur
VANSEnvelope indeholder enten en meddelelse eller en kvittering. Meddelelse indeholder data som
er en base64 encoded streng. I kuverten angives altid afsender og modtager, et UUID for konvolutten
samt afsendelsestidspunktet. Hvis konvolutten anvendes til forsendelse af en meddelelse anføres et
UUID for meddelelsen samt en række metadata der beskriver meddelelsen.

Kuverten kan desuden anvendes til forsendelse af tre kvitteringstyper

• NegativVANSkvittering Afsendes af VANS, hvis en kuvert ikke er valid, afsender ikke er korrekt
eller modtager ikke kan findes.

• Negativmeddelelseskvittering Afsendes af modtagersystemet, hvis en meddelelsestype ikke accep-
teres, meddelelsen ikke er valid eller relevant.

• Positivmeddelelseskvittering Afsendes af modtagersystemet, hvis en meddelelse er godkendt.

Skemaet til VANSEnvelope 1.0.2 kan findes på:

http://sundcom.health-telematics.dk/svn/VANSEnvelope/VANSEnvelope_1.0.4.xsd

Reliabilitet
Der sikres vished for om en meddelelse er modtaget eller ej ved at stille følgende krav til de involverede
systemer.

VANS leverandøren skal skemavalidere alle kuverter ved modtagelse og kvittere negativt ifald en
kuvert ikke er valid eller ikke kan routes.

Modtagersystemet skal altid kvittere på en meddelelse enten negativt eller positivt. En positiv kvitte-
ring sendes først, når systemet har foretaget alle check. En negativ kvittering sendes derimod, så snart
systemet opdager en fejl.

Afsendersystemet forventes at kunne gensende en meddelelse flere gange ifald det endnu ikke har
modtaget enten en negativ eller positiv kvittering. Meddelelsen skal gensendes x

3, hvis der ikke er modtaget en kvittering. Hvis modtagersystemet modtager en meddelelse som det
allerede har kvitteret for gensendes kvitteringen.

http://sundcom.health-telematics.dk/svn/VANSEnvelope/VANSEnvelope_1.0.4.xsd
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Kapitel 2. Beskrivelse af forløb
De følgende figurer beskriver behandlingsforløbet for en meddelelse samt kvitteringer i henholdsvis
afsendersystemet, VANS og modtagersystemet.

Oversigt
Figur 2.1. Sekvensdiagram

Beskrivelse
Afsenderen bygger meddelelse og indpakker den i en VANSEnvelope, som så afleveres til VANS
udbyderen. VANS udbyderen validere kuverten, finder modtageren, og lægger kuverten over i mod-
tagerens indbakke.

Når modtageren tjekker sin indbakke, hentes kuverten ned. Modtageren tjekker metadata for at sikre
sig at kuverten indeholder en besked systemet understøtter. Modtageren pakker beskeden ud og ind-
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læser den, hvis alt dette går godt, bygges en positiv VANSEnvelope kvittering. Kvitteringen afleveres
til VANS, som igen validere, finder modtager og lægger kuverten i modtageres indbakke.

Når modtageren (oprindelig afsender) modtager den positive kvittering, ændres status på den oprin-
delige forsendelse, fra afsendt, til afleveret og forløbet er afsluttet korrekt.

Forløb for afsendersystemet
Figur 2.2. Flow for afsender

Beskrivelse
Start System skal afsende en meddelelse.

Byg meddelelse Meddelelsen sammensættes.

Byg konvolut Meddelelsen indpakkes i en VANSEnvelope.

Send til udbakke Konvolutten lægges i udbakken hos VANS leverandør.

Hent fra indbakke Der tjekkes efter svar, i indbakken hos VANS leverandør.

Svar Hvis der svar tjekkes der om det er en negativ eller positiv kvittering.

Timeout Hvis der ikke er kommet noget svar, testes der på om der er noget timeout
på forsendelsen.

Gendsend Ved timeout tjekkes om meddelelsen er blevet gensendt tre gange, hvis
ikke sendes meddelelsen igen i en ny kuvert.
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Forløb for VANS

Figur 2.3. Flow for VANS

Beskrivelse

Start Der er modtaget en VANSEnvelope fra en kunde (afsender).

Læs fra afsender Kuverten indlæses.

Valid Tjek om kuverten er gyldig.

Parter Hvis kuverten er gyldig, tjekkes at afsender er den samme som det
der er registreret på kunden, og findes modtager.

Send til modtager Hvis parterne er ok, afleveres kuverten i modtagers indbakke.

Byg negativ kvittering Hvis kuverten ikke er gyldig, eller parterne ikke er findes / korrek-
te laves der en negativ VANS kvittering, som lægges i afsenders
indbakke.
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Forløb for modtagersystemet
Figur 2.4. Flow for modtager

Beskrivelse
Start Der anmodes om at tjekke indbakke.

Læs fra indbakke VANSEnvelope hentes fra VANS leverandør.

Type Er det en meddelelse eller kvittering.

Accept Tjek om indholdet i kuverten er supporteret af systemet.

Udpak Pak meddelelse ud af kuvert.

Valid og relevant Kan meddelelsen forstås.

Byg positiv kvittering Hvis meddelelsen kan forstås, bygges en positiv kvittering.
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Send til udbakke Kvitteringen lægges i udbakke hos VANS leverandør.

Byg negativ kvittering Hvis meddelelsen ikke er supporteret eller går i fejl, bygges en
negativ kvittering.
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Kapitel 3. XML Facitliste
VANSEnvelope består af følgende objekter:

• VANSEnvelope
• SenderID
• ReceiverID
• EnvelopeIdentifier
• SentDateTime
• Message

• MetaInformation
• Identifier
• Processing

• Provider
• Service

• Document
• Format
• Name
• Version
• SizeInBytes

• Transport
• Type
• TransformMessage
• ServiceTag (op til 5 gange)

• Data
• Receipt

• NegativeVans
• Error

• Code
• Description

• OriginalEnvelopeIdentifier
• NegativeMessage

• Error (se VANSEnvelope/Receipt/NegativeVans/Error)
• OriginalEnvelopeIdentifier
• OriginalMessage (se VANSEnvelope/Message/MetaInformation)

• PositiveMessage
• OriginalEnvelopeIdentifier
• OriginalMessage (se VANSEnvelope/Message/MetaInformation)

Dataliste
Tabel 3.1. Dataliste

XML Element Type Beskrivelse

Namespace: urn:oio:medcom:vans-envelope:1.0.4

VANSEnvelope VANSEnvelopeType  

SenderID an..18 Identifikation af afsender.

ReceiverID an..18 Identifikation af modtager.

EnvelopeIdentifier UUID Identifikation af kuverten.

SentDateTime DateTid Tidspunkt for afsendelse.

Message MessageType Meddelelsen.

MetaInformation MetaInformationType Meta information omkring meddelelse.

Identifier UUID Identifikation.

Processing ProcessingType Angivelse af ønsket bearbejdning af meddel-
else inden vidersendelse.
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XML Element Type Beskrivelse

Provider an..255 Navn på udbyder.

Service an..255 Navnet på den service der skal udføres.

Document DocumentType Dokument i meddelelse.

Format Enum Format på data indholdet i meddelelse.

Name an..255 Navn på dokument type.

Version an..255 Version af dokumentet

SizeInBytes n Størrelsen på meddelelsen i bytes.

Transport TransportType Information vedr. transport af kuverten.

Type Enum Angiver om transporten skal være reliable el-
ler unreliable. Den er reliable som default.

TransformMessage Bool Angiver om VANS må transformere meddel-
elsen inden modtagelsen.

ServiceTag an..70 Mulighed for at sætte yderligere informatio-
ner omkring meddelelse, til brug for modtager
eller VANS.

Data Base64 Data som udgør selve meddelelsen.

Receipt ReceiptType Kvitteringsmeddelelse.

NegativeVans NegativeVansType Negativ kvittering fra VANS.

NegativeMessage NegativeMessageType Negativ kvittering fra original modtager.

PositiveMessage PositiveMessageType Positiv kvittering fra orignal modtager.

Error ErrorType Indholder informationer omkring opstået fejl i
leveringen af kuvert.

Code n Eventuel fejl kode.

Description an..512 Beskrivelse af fejl.

OriginalEnvelopeIdentifier UUID UUID på den kuvert der kvitteres for.

OriginalMessage MetaInformationType Meta information på den meddelelse der kvit-
teres for.

@EndPointType Enum Angiver typen af identifikation på afsender.

@name an..70 Nøgle til information.

Typeliste
Tabel 3.2. Typeliste

Element Antal Definition

Namespace: urn:oio:medcom:vans-envelope:1.0.4

VANSEnvelopeType  Grund type for alle kuverter.

 SenderID 1 Afsenders ID.

 ReceiverID 1 Modtagers ID.

 EnvelopeIdentifier 1 Kuvert ID.

 SentDateTime 1 Tidspunkt for afsendelse.

 Message 0..1 Meddelelsen, hvis det ikke er en kvitteringskuvert.

 Receipt 0..1 Kvittering, hvis det ikke er en meddelelseskuvert

EndPointType
 Type for identifikation af parter på VANS-netværket. Selve værdien er

en streng uden mellemrum.

 @EndPointType 1 Type af identifikation.

MessageType  Indeholder meddelelse og information herom.

 MetaInformation 1 Indformtion omkring indholdet i meddelelsen.

 Data 1 Selve meddelelsen, som base64 enkodet data.

MetaInformationType  Indformtion omkring indholdet i meddelelsen.
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Element Antal Definition

 Identifier 1 Identifikation på meddelelsen.

 Processing 0..1 Mulig bearbejdning af meddelelse, inden levering hos modtager.

 Document 1 Information omkring det dokument der udgør meddelelsen.

 Transport 0..1 Information omkring service hos VANS og modtager.

Processing  Mulig bearbejdning af meddelelse, inden levering hos modtager.

 ProviderIdentifier 1 Identifikation af udbyder for bearbejdning.

 ServiceIdentifier 1 Identifikation på bearbejdnings service.

Document  Information omkring det dokument der udgør meddelelsen.

 Format 1 Data format som beskeden er i.

 Name 1 Navn på typen af besked.

 Version 0..1 Version af format på besked.

 SizeInBytes 1 Original størrelse på besked i bytes, før den base64 enkodes.

TransportType  Information omkring service hos VANS og modtager.

 Type 0..1 Typen af service, reliable eller unreliable. Default er unreliable.

 TransformMessage 1 Boolsk angivelse af om VANS må behandle beskeden inden modtagelse.

 ServiceTag 0..5 Mulighed for at sætte yderligere informationer omkring meddelelse, til
brug for modtager eller VANS.

ServiceTagType
 Mulighed for at sætte yderligere informationer omkring meddelelse, til

brug for modtager eller VANS. Indeholder en streng som værdi.

 @name 1 Navn til den værdi man vil tilknytte meddelelsen/kuverten.

ReceiptType  Kvittering på en tidligere kuvert.

 NegativeVans 0..1 En negativ VANS-kvittering.

 NegativeMessage 0..1 En negativ kvittering fra original modtager.

 PositiveMessage 0..1 Positiv kvittering fra modtager.

NegativeVansType  En negativ VANS-kvittering.

 Error 1 Angivelse af en fejlen.

 OriginalEnvelopeIdentifier 1 Identifikation af den originale kuvert.

NegativeMessageType  En negativ kvittering fra original modtager.

 Error 1 Angivelse af en fejlen.

 OriginalEnvelopeIdentifier 1 Identifikation af den originale kuvert.

 OriginalMessage 1 Information omkring den meddelelse der blev sendt.

PositiveMessageType  Positiv kvittering fra modtager.

 OriginalEnvelopeIdentifier 1 Identifikation af den originale kuvert.

 OriginalMessage 1 Information omkring den meddelelse der blev sendt.

ErrorType  Angivelse af en fejl i transporten.

 Code 0..1 Kode på fejl, hvis en sådan findes.

 Description 1 Beskrivelse af selve fejlen.

Enumerationsliste

Tabel 3.3. Enumerationsliste

XML Element Værdi Beskrivelse

Namespace: urn:oio:medcom:vans-envelope:1.0.4

Format XML XML dokument

Format EDIFACT Edifact dokument

Format HL7 HL7 dokument, version skrives i
Version elementet.
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XML Element Værdi Beskrivelse

Format Binary Binært dokument

Format Other Andet format

EndPointType EAN EAN identitet

EndPointType CVR CVR identitet

EndPointType VANS VANS specifikt identitet

Type reliable Kvittering for modtagelse

Type unreliable ingen Kvittering for modtagelse
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Kapitel 4. Eksempler

Meddelelses kuverter

Eksempel 4.1. Komplet eksempel

<?xml version="1.0" encoding="UTF-8"?>
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 http://svn.medcom.dk/svn/drafts/
VANSEnvelope/VANSEnvelope_1.0.4.xsd">
  <SenderID EndPointType="EAN">5790000141289</SenderID>
  <ReceiverID EndPointType="EAN">5790000141227</ReceiverID>
  <EnvelopeIdentifier>6060d470-6e28-11df-be2b-0800200c9a66</EnvelopeIdentifier>
  <SentDateTime>2010-03-18T12:17:43</SentDateTime>
  <Message>
    <MetaInformation>
      <Identifier>6f4eb2e0-6e28-11df-be2b-0800200c9a66</Identifier>
      <Processing>
        <ProviderIdentifier>ConvertOmatic</ProviderIdentifier>
        <ServiceIdentifier>text2pdf</ServiceIdentifier>
      </Processing>
      <Document>
        <Format>Other</Format>
        <Name>TXT</Name>
        <Version>1.0</Version>
        <SizeInBytes>11</SizeInBytes>
      </Document>
      <Transport>
        <Type>unreliable</Type>
        <TransformMessage>false</TransformMessage>
        <ServiceTag name="Content">Hello World</ServiceTag>
        <ServiceTag name="Encoding">UTF-8</ServiceTag>
        <ServiceTag name="Purpose">Greeting</ServiceTag>
        <ServiceTag name="Newline">None</ServiceTag>
        <ServiceTag name="Language">English</ServiceTag>        
      </Transport>
    </MetaInformation>
    <Data>SGVsbG8gV29ybGQ=</Data>
  </Message>
</VANSEnvelope>

    

Eksempel 4.2. Minimalt eksempel

<?xml version="1.0" encoding="UTF-8"?>
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 http://svn.medcom.dk/svn/drafts/
VANSEnvelope/VANSEnvelope_1.0.4.xsd">
  <SenderID EndPointType="EAN">5790000141289</SenderID>
  <ReceiverID EndPointType="EAN">5790000141227</ReceiverID>
  <EnvelopeIdentifier>5dbb1360-6e29-11df-be2b-0800200c9a66</EnvelopeIdentifier>
  <SentDateTime>2010-03-18T12:17:43</SentDateTime>
  <Message>
    <MetaInformation>
      <Identifier>67ab0560-6e29-11df-be2b-0800200c9a66</Identifier>
      <Document>
        <Format>Other</Format>
        <Name>TXT</Name>
        <SizeInBytes>11</SizeInBytes>
      </Document>
    </MetaInformation>
    <Data>SGVsbG8gV29ybGQ=</Data>
  </Message>
</VANSEnvelope>
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Komplet flow

Meddelelse
Denne meddelelse indeholder et JPEG billede på 4.455 bytes, som desuden har dimensionerne
131x131 pixels. Billedet kan ses herunder.

Figur 4.1. Indhold i meddelelse

Eksempel 4.3. Meddelelses kuvert

<?xml version="1.0" encoding="UTF-8"?> 
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4" 
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
    xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 http://svn.medcom.dk/svn/drafts/
VANSEnvelope/VANSEnvelope_1.0.4.xsd"> 
  <SenderID EndPointType="EAN">5790000141289</SenderID> 
  <ReceiverID EndPointType="EAN">5790000141227</ReceiverID> 
  <EnvelopeIdentifier>cb8cec50-327f-11df-9aae-0800200c9a66</EnvelopeIdentifier> 
  <SentDateTime>2010-03-18T12:17:43</SentDateTime> 
  <Message> 
    <MetaInformation> 
      <Identifier>bc1c08e4-be16-4108-a386-25200966c750</Identifier> 
      <Document> 
        <Format>Binary</Format> 
        <Name>JPEG</Name> 
        <SizeInBytes>4455</SizeInBytes> 
      </Document> 
      <Transport> 
        <TransformMessage>false</TransformMessage> 
        <ServiceTag name="ImageWidth">131px</ServiceTag> 
        <ServiceTag name="ImageHeight">131px</ServiceTag>         
      </Transport> 
    </MetaInformation> 
    <Data>/9j/4AAQSkZJRgABAQAAAQABAAD/2wBDAAkGBwgHBgkIBwgKCgkLDRYPDQwMDRsUFRAWIB0iIiAd 
      Hx8kKDQsJCYxJx8fLT0tMTU3Ojo6Iys/RD84QzQ5Ojf/2wBDAQoKCg0MDRoPDxo3JR8lNzc3Nzc3 
      Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzc3Nzf/wAARCACDAIMDASIA 
      AhEBAxEB/8QAGwAAAgIDAQAAAAAAAAAAAAAABAYABQIDBwH/xAA/EAACAQMCAwUFBgUDAgcAAAAB 
      AgMABBEFIRIxQQYTUWFxIjKBkaEUI1JyscEVQmLR8AckQzSyJTNEU8Lh8f/EABoBAAMBAQEBAAAA 
      AAAAAAAAAAIDBAUBAAb/xAAnEQACAgICAgICAgMBAAAAAAAAAQIRAyESMQRBIlETMnGBFCNhkf/a 
      AAwDAQACEQMRAD8AuSC1S8bhtJEHhzr2aZbeMM2AWOBWF1k2sjHmVrIvZ9QltCfCdjv1NGWp50Bb 
      sCp36mjrXlzqyYSQcDtvWWdq1D1rPB4eIg46HpS6C6MmbGxNeBhnnW2O170gGQD64o0aIGAMdyeL 
      +pNq7xYqWbHHtlax86wbdaJvbK5siDcJ7B2Ei7r/APXxoRmAB3r1UHFxkrRs0iUpcNH0O9XRQAc6 
      XrE/7vbwq8SQkb86HIgWjLiKEFTgg5Bqx1q2/jeipdQDNzbZPCOviP3qqeUY2o3QNQ+y3vDIcRS7 
      HyPQ0na2hWSDrku0K6NxKDWjVL+HTrfjkIaRvcjzu3n6VaduoU7O3RuVAaK6JaGMfi6j03z8a5zP 
      cS3Mzz3DFpH+QHgPKrsOP8nyfRx5VxtBza9q7HK3sqL0VSAAPAVKqst0zUqzhH6Qm2dA1W/N3q0M 
      UZ+7jccuppgvDiyY/wBNJVp/1UPP3xvTnd/9C35aycsUqSLk+hItRs35jR9vQFs2eIdOI0dAwVSe 
      e1UzPRDOMIMtuPDxrxHYnLnJJzXl8jQXbW7c41Ab82Mn67fCtlsi5DPS4/Z6TtBkBYEEA0wWDgxA 
      sQOlUEKyTv3VuuSN2P8AKo8zTHYQpbKMN3kg/m8PT/M0RFnqiwSHvYysiDgYbhxnI9P70rdp9AGn 
      Wxv7Au9uG++jP/EDyI8s/KmxHB945PTFbgysCjAFWGCrb5HnRJEcMsscrRy/SXD3o9KsdYuxp8H2 
      jfgBHF5Vv1jRk0jtFFLaLw2V2pZFA2jce8o/UfHwqt7YY/g0vFtQNJ5EjVhkU4ckWMbpLEJIzlWG 
      Qa8mmitoJJ524Yo14mNBdgdO1PUNOJmTurf/AIZJOcg8QPDz5eGaqv8AUQ3VnfRaRL7MYRZmZTtJ 
      nOPgMH415YG8nE5/kY609lFr2tXmvXgub12KRjghjP8AIvh6+J60JbW8lzKERSzHbA6+VajjbHQd 
      KeeymjNawLPOuJ5BnB/kXoPWrm4446JasFtexto1uhvbqdZyMusRwoPgKlOSsFAAGAKlRPNkvsOl 
      9CZbgd/H+YU43C509yfwUn2iZuY/UU53A/2D/kpGbtFj9CFa7Btupq00hBPqNrARtJOgPpnf6VVW 
      5yG/MatuzxH8esAxwDLj44OPrinz9nHqLM9WWT+JzyvzkkLZ6VttkaU4BwAPabGceVHdordBMyEn 
      iUqcYzsaFiK8A2xHyC/i/wA+tBjdxR69aLOyZYwqIOGPoOrHxz+9WiTHkuPDI/znVAs/CCz9emf8 
      +dak1wfaPs7FIjwkqzHI26Y502OOUuiXJFexrin4cjPrk863rOc8THC42UGkmbtXZWyF5VlGN9l/ 
      virzRLmbVrdZ+6lgQ8g+xx0PkD8/hvROEoq5ImlCL9lvcPFeRdxKgYH2gfwHo3lQa6BbXAQ6iizh 
      TkRsPYz5j+b47eRqwijWLAjwPPFe3d5aafF3t7cJEp5FjufQczQduxanKKcI+whXSPhXIQMcAdTi 
      uU/6qXaXHasxIQRbWscZx4nLH/uFNVzrsV1PJeSAw6XbjLzS7F8b8KDqxrll3cy6lqE91MpMtzMX 
      Kg5wWOw/b4U/Atthxx8XbLTsppX268WeUZhgYFl/E3QV0QLwrjr1oDRLBbCxihAGUHtHxbrR5JpO 
      afKRStHntVK84qlJO2KkTBLmM/1CnKYZsW/JSSp+/j/OKd3H+wb8lDmW0VN9HPrY+/8AmP60Zbl0 



Eksempler

15

      kSaI4kicOh8CDkUNbAcT/mP60dbAYbaqJnY7GfXnjubG1vkUot0oPD1xjcee9Ujyqi95IwVPHOAP 
      IVlLcrLDHaSuM6eGVwG9wMcgHw32+lKmrX8lxKeDaBZEAQnZuZHpsoPxrvj4m9ehLkoRCdR1eWdH 
      EDeyG4cDY48/KqtpjbSzKXPE+3EdiU6Yxyzz26VpiykjCM8QXGfBsb/saauy+jC/lTULiNu5gBES 
      59nGThh8CMeHPqKubjihZK25PYT2a0NL+7+03akxIdkKnCEE4wDz6ehB8sPCui4WAYXOAB9fU0Fc 
      XFtprvGzpGHUcK8go8+gorTmRikgdXVh7JU5HwqLNk5ysBY21fomsy3ltpM81lwLOi5ywzgdcDxp 
      RsNQtJbee+1JmuVhXiZmHG2fIHx+QroU/cyWcyysqoUIJY4ArjNmQBrtijB0MRkXHLKsD/evY0pJ 
      oPGkla7NOva5ca5OrMvc2kOe5t1OQv8AUfFvP5Vn2UtTPqAnK5WI8WPFjy/vVU68MfDyzzp77H2I 
      g09Gce1J943x5D5U+bWOGjqGQKFQKOgrWwrwhlXKv8DWtpmHvL8aiSZ2yHnUrWZUz7wqV0KhRZ2W 
      aIH8a/rT8wP8OJH4K5jJOWuIc7ZkX9a6cG/8OI/ooPIjVFN3Qg26N94egY1aaXJbWtjNeagRBwkN 
      EZTguuOQTnknqfDpzoKx9kTTMoKIzHJbAGN6Cvg15fo0wD8RBKqDnBOMnJ6Z5H5DerMeH8nYvPl4 
      aRp1G9murt2aFYVkGe64QpYDq5HPr16mhdVQ280IkGI5EySv4snJHzHwxWOpXEiamBjAiPAkeSce 
      nh05UTfxSXWky3c6LE0MhWMZwCAMsPXmR6HFV/GCpEfyk7YJo1lJq2ow2yKQcATMrY4l8/l9M11C 
      +mGnaf8AYdPVPtfCMAjaIdCfPwH7c1XQ2j7NdnG1SZFN7ctwW8TfzOR18lBGfUjrR2hyvIizSuZJ 
      JfakdubMeZNRZ5Nu/RRhx83/AABaXp2pXt1Iup6rLbq0bEkMM8Z5bfzb/TrV12YilguorWThVywD 
      lRgM3jirhe54ONVHFiqy2mVNVgcHlJk/Okyny0Pin8is7WPe3d/d9/OLazgVu4RccTMNhkdcnw6U 
      raAZJtUn73Jd7eVDnmTwMf2ro3aeNPtcwIGzfTnXPtAkU9o4XHuSTSJ6go4p+KWmqEtf60/srIrd 
      rnUI7ZCd3CZ8B1NdNt1WGAKowDyHl0pI7K2TSa1MX/4OJSfBiSv6A09SbcuQofIlbUQFo9LYFai7 
      yHghUux6AVg3E7LHGMsxwBTLp9klvEI0ALndn8TU0pqH8gyZQjSLphxEIpPQmpTR3CjmTUofzTFc 
      0cUijS4vbdCcfeA7etdPUf7Jl8ErluiEyX0exPAeI/MV1RSDYk+KU3yl0i9P2c/LMLS9KgALxDA2 
      zk8vWgmmAuSjnhwVzw8lA6ep5nw286MneNrWRCOFZZinjwqGBYnzPP0AFBaIn2hpnZgZO5LDj6ks 
      AM+PjWl46aRL5LVnusWivK14jcKOpYMBn70McD48qOttKZ/sOo6pKgt1IIgk5MF3Yt4KPoMCitOt 
      4xcqkuBh8KmMgPyBJ+O1DdudVFzfz2kThiDwylPdUDlGvkDuT1PpuOW+fFC4fqVmral/FtYhlRe7 
      tIZQkEePdUtnJ8zz8uVM+kr3cEajoMUjRtuWY78QY/A5po0a+Up3ZIyGqbPH4qvRd4zSbQ2RSAqQ 
      TitVppdxcXHFDMFjVgTlc8zQkiGZVKM6uPwsRmt8MLrGxdbgMykcffED5CpkUSVJ0wXtzqLQRTsW 
      +9c92vrjGfkKSNNb7LdafNn3bhGPpkA/TNbe0N//ABDUCsLEwQghCTniJ5t8a0SKfsiN4DiHzBFW 
      wjxil9kLdul0h50SzFtcX82N5blm+A2/XNWLGso0Cg467/PesJBgVJfJ2C2kFaHH3t+zkZ7tdvU0 
      0xoFGKoOySiSe7b8PCP1pkxw+Zqea+exGSXox4alTiPlUr3JCaZwe2huNIvwbhCF2Geh3FdQhbjs 
      Rw4AMe2aS7mddR7Ei/lUGaNgCR4hgKdLZQdLXziqny+02aGGXKP9nNtXZIbqCCJZOJy5HEd2zkA8 
      PQE8h4DPWtWmKiSMLglYbhDEp5cLBsj/ALTWrtFOZNeu5nIJDnHLY+HwP6VpmaRYLdpHctKhY5bc 
      pkgfQZ860seoomntuxpt5mMPdSqssxj3C5GCDlcnY74Pzpe1iyW0upmRy8bKSCdyrEZ4SevPY9fn 
      Rml3QWRrlHyeMcQ5ZyefzP19KM7QW+bfUVERCxQpKrhc8TlxxfQsfi3jRzV7FRfFiswKyNtyNWGm 
      QC4uljLtHj2gy8/OgpdpH5bjp41fWEDR3GnsV4WeN+L6H96mytKJbii3IZLBWixmaR8fix+wq5ii 
      OoxvEZGiUrjjABqqiAVccqtbGThwBWe5FOVOtCTr3YnUtJge4tgL22Rcl4h7agdSv9s1Vko9pGow 
      cxgCu12MhON651290FNN7Q2FxZoFtNRlVWQDZJAwLAeAIOfnVWPM56kQQlUuLLK4muY5W4ADGNgP 
      Shn1Ie5LGysTjYZo5ztk86HjtzeXcUES8UjtsKSmqthumMXYt0bT7iVclnnKttywBQfbDtd/Cs2m 
      nhJr4j3TusY8W/tVuqx6BoEjMR7AZjj+Zia5hwl3kupcPLNIXP8AUxpONLJNyfRyGNSbfoj672hk 
      Yu+sTKx3KoqgD0GKle8CdQM9cmpVnFfS/wDENqJ5oX3/AGD1CEbiNm38ORp5sTxaTER/7Q/Slrsw 
      lvJoOow26YDxksuORIpk0nfR4/HusfSk+W7F4Ncl/wBOWa2qrrNyScrxlhtz32oZ2ZkUyN7o4T1O 
      5JrZqEnfX8rpyGOH4AcqlvCZW7osFLPwjPoT+1aUekLl2FaSWhAuVV2WEZfgHMEY5dcYHz8qL1a+ 
      Z7cyLOeEy/8AkOoZW5+2Afd8P/2gtLMlpcRyKxRsYYHkwzwsD44/etOvMTqMihVUqAvsnnz/AM+n 
      Sjk9C0rkZ2Kfb72NVjVVX3uEYBppgVZ9UHD7tvHwk/1Hp8gKpdFgnig4baAiRxvLLsF9B1+lMemW 
      y2kPdglmJ4nc82Y8yazc09mnhhSDiuAPKiLZ8Y3rSoyMV6gKNtUtjpK1Qy6dLyFY9rLOO70dZpP/ 
      AEUq3IOOXDkH6E0DYSkMKYYwlzbvFJgpIhRh4gjBpkGZWVcJ2c7i1azn5yd2fB9qsdKm+zXkd3GB 
      KM8IAPPO1Kt3Z5aW1lX7yF2jb1BxVt2VuYNA068W5DyytIrwoBknHTPQZo8sfg6HJb0X/b6/EMVv 
      aFhxEcTLnmelJCyFgCOQ2QePiaw1G7udW1Oa+1BguTso5KOiivI2P2d7qQcK4wg8qLDi4R32GpcY 
      8Qaa7t0kZXyWB3NSquRoi5LZyTmpVXEVY8f6WkmHVAeXCn/ypgsTjQyR0hb9KlSo/K/Y5h7l/Rya 
      P2rh8/iP7UcFCxxFRglpifguBUqVqIWzK996F/5pHYsfHMa5+deQxpMLaaRQ0mMcXjsvPx51KlBl 
      /VhYf3Qz2wHANqMj5ipUrGZro3xcq3LyqVK6DILttiMVf2JPCKlSjgZ3kiB2kURdqbwIMcThj5kq 
      M1HjULI3CMquR5VKlHl9DfH6F4/eOwfcBhive07GNYI0PCmPdFSpVa7QqRstrWA28ZMSkkeFSpUp 
      Em7ZXFKkf//Z</Data> 
  </Message> 
</VANSEnvelope> 

        

Ukendt modtager
Ifald VANS ikke kunne finde modtagerne til denne meddelelse ville kvitteringen se således ud.

Eksempel 4.4. Negativ VANS kvittering
<?xml version="1.0" encoding="UTF-8"?> 
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4" xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" 
  xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 http://svn.medcom.dk/svn/drafts/
VANSEnvelope/VANSEnvelope_1.0.4.xsd"> 
  <SenderID EndPointType="EAN">5790000141289</SenderID> 
  <ReceiverID EndPointType="EAN">5790000141227</ReceiverID> 
  <EnvelopeIdentifier>7bf64083-0a1a-44dc-9a0a-feb80820155a</EnvelopeIdentifier> 
  <SentDateTime>2010-03-18T12:17:57</SentDateTime> 
  <Receipt> 
    <NegativeVans> 
      <Error> 
        <Code>1</Code> 
        <Description>The recipient '5790000141289' does not exist.</Description> 
      </Error> 
      <OriginalEnvelopeIdentifier>cb8cec50-327f-11df-9aae-0800200c9a66</
OriginalEnvelopeIdentifier> 
    </NegativeVans> 
  </Receipt> 
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</VANSEnvelope> 

        

Ukendt type
Hvis modtagersystemet ikke kan håndtere meddelelser af typen JPEG kunne det sende følgende ne-
gative meddelelseskvittering.

Eksempel 4.5. Negativ meddelelseskvittering
<?xml version="1.0" encoding="UTF-8"?> 
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4" xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" 
  xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 http://svn.medcom.dk/svn/drafts/
VANSEnvelope/VANSEnvelope_1.0.4.xsd"> 
  <SenderID EndPointType="EAN">5790000141227</SenderID> 
  <ReceiverID EndPointType="EAN">5790000141289</ReceiverID> 
  <EnvelopeIdentifier>66f2b4b7-1cbd-4049-96cf-2948c80618e4</EnvelopeIdentifier> 
  <SentDateTime>2010-03-18T12:19:31</SentDateTime> 
  <Receipt> 
    <NegativeMessage> 
      <Error> 
        <Description>The recipient system does not handle 'JPEG' documents.</Description> 
      </Error> 
      <OriginalEnvelopeIdentifier>cb8cec50-327f-11df-9aae-0800200c9a66</
OriginalEnvelopeIdentifier> 
      <OriginalMessage> 
        <Identifier>bc1c08e4-be16-4108-a386-25200966c750</Identifier> 
        <Document> 
          <Format>Binary</Format> 
          <Name>JPEG</Name> 
          <SizeInBytes>4455</SizeInBytes> 
        </Document> 
        <Transport> 
          <TransformMessage>false</TransformMessage> 
          <ServiceTag name="ImageWidth">131px</ServiceTag> 
          <ServiceTag name="ImageHeight">131px</ServiceTag> 
        </Transport> 
      </OriginalMessage> 
    </NegativeMessage> 
  </Receipt> 
</VANSEnvelope> 

        

Modtaget korrekt
Hvis modtagersystemet har modtaget meddelelsen korrekt og kan anvende den skal det kvittere posi-
tivt på følgende måde.

Eksempel 4.6. Positiv meddelelseskvittering
<?xml version="1.0" encoding="UTF-8"?> 
<VANSEnvelope xmlns="urn:oio:medcom:vans-envelope:1.0.4" xmlns:xsi="http://www.w3.org/2001/
XMLSchema-instance" 
  xsi:schemaLocation="urn:oio:medcom:vans-envelope:1.0.4 http://svn.medcom.dk/svn/drafts/
VANSEnvelope/VANSEnvelope_1.0.4.xsd"> 
  <SenderID EndPointType="EAN">5790000141227</SenderID> 
  <ReceiverID EndPointType="EAN">5790000141289</ReceiverID> 
  <EnvelopeIdentifier>38329bbc-23e0-47bc-b582-57ec46b282e5</EnvelopeIdentifier> 
  <SentDateTime>2010-03-18T12:19:11</SentDateTime> 
  <Receipt> 
    <PositiveMessage> 
      <OriginalEnvelopeIdentifier>cb8cec50-327f-11df-9aae-0800200c9a66</
OriginalEnvelopeIdentifier> 
      <OriginalMessage> 
        <Identifier>bc1c08e4-be16-4108-a386-25200966c750</Identifier> 
        <Document> 
          <Format>Binary</Format> 
          <Name>JPEG</Name> 
          <SizeInBytes>4455</SizeInBytes> 
        </Document> 
        <Transport> 
          <TransformMessage>false</TransformMessage> 
          <ServiceTag name="ImageWidth">131px</ServiceTag> 
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          <ServiceTag name="ImageHeight">131px</ServiceTag> 
        </Transport> 
      </OriginalMessage> 
    </PositiveMessage> 
  </Receipt> 
</VANSEnvelope> 
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